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[bookmark: _Toc104029946]Administrative matters
[bookmark: _Toc104029947]Getting around
[bookmark: _Toc104029948]Laboratory & office locations
· The Adikes Lab is located on the 1st floor of Morell Science Center

[bookmark: _Toc104029949]Other facilities
· Autoclave room: Morell 1XX
· Microscopy room: Morell 1XX
· Biology Department Administers office (Eileen Martio): Morell 
· School of Science Office: Roger Bacon 212
[bookmark: _Toc104029950]Getting started
[bookmark: _26ooe8xmq8d7][bookmark: _Toc104029951]Environmental Health & Safety (EHS) training
· Before getting started in lab, all new lab members must complete the following Environmental Health & Safety (EHS) training modules:
· Awareness Level Laboratory Safety and Emergency Training
· Laboratory Safety Training for New Employees (including Student Workers)
· First Aid Kit and Medical Emergency Training
· Regulated Medical Waste Management 
· Working Alone in School of Science Laboratories
· Autoclave Training AMSCO 250LS
· Centrifuge and Rotors Safety Training
· If you will be working with fixed samples: Formaldehyde Safety Training

· These are all accessible online through Canvas on the School of Science Safety page

[bookmark: _8y5behasb3d4][bookmark: _Toc104029952]Laboratory Access
	The lab had a key code pad which Dr. Adikes will provide to you.

[bookmark: _Toc104029953]Lab communication
[bookmark: _Toc104029954]Email
· For most communications we use email
[bookmark: _Toc104029955]Google Calendar
· Dr. Adikes uses Google Calendar to book appointments and there well be a goggle calendar for the epifluorescence microscope. 
[bookmark: _Toc104029956]Lab meetings
· lab meetings will be held one a week – at a time which everyone is free. Meeting will be held in Dr. Adikes’ office or in an alternative space should more room be needed
· Emergency contacts: Dr. Adikes’ cell – 607-434-4971
· Emergencies regarding failure of incubators (particularly the -80 °C freezer in the hall) or issues with microscopes should be reported immediately to Dr.A. If there is a more serious emergency (i.e., medical event, gas leak, fire, etc.), contact Siena College Public Saftey: 518-783-2999

[bookmark: _Toc104029957]Travel Funds
· CURCA has some funds available for travel to a conference to present your work
· Most conferences also have applications for travel funds for undergraduates 

[bookmark: _Toc104029958]Poster printing
· [bookmark: _7cprpdjayu1z]Poster printing services are available through Siena College. Ask Dr. Adikes to help you check the format and send the print request 


[bookmark: _Toc104029959]Literature and online resources
[bookmark: _Toc104029960]WormBook
· WormBook (http://www.wormbook.org/) is a “comprehensive, open-access collection of original, peer-reviewed chapters covering topics related to the biology of Caenorhabditis elegans and other nematodes.” Chapters of particular interest include:
· A transparent window into biology: A primer on Caenorhabditis elegans
· Basement membranes
· Cell cycle regulation
· Morphogenesis of the vulva and the vulval-uterine connection
· Vulval development
· WormMethods
[bookmark: _Toc104029961]WormBase & Tools
· WormBase (https://wormbase.org/) is an online biological database for C. elegans. We typically use this resource to collect information about specific genes. You can search for a gene using the search bar at the top of the screen and navigate through the following tabs in the resulting page:
· Overview: short description of the gene, including its sequence identifier, and its known function(s)
· Expression: images, tables, and graphs showing expression patterns and levels
· Genetics: list of alleles
· Homology: table of homologs/orthologs/paralogs in other species
· Interactions: network diagram and table of known genetic/physical/regulatory interactions with other genes/proteins
· Location: chromosomal location and genomic context shown genome browser
· Phenotypes: table of phenotypes observed in alleles, following RNA interference (RNAi), or other perturbations
· References: list of references (including meeting abstracts) mentioning the gene
· Sequences: links to transcripts (spliced, unspliced, etc.) for different gene isoforms
· ParaSite (https://parasite.wormbase.org/index.html) is a subportal of WormBase. It offers additional tools and features including:
· BLAST (basic local alignment search tool): sequence search tool 
· BioMart: data mining platform
[bookmark: _Toc104029962]WormAtlas
· WormAtlas (https://www.wormatlas.org/index.html) is a “database featuring behavioral and structural anatomy of C. elegans.” It contains many resources, some of which are highlighted below:
· Handbooks: visuals and descriptions of C. elegans anatomy and development
· Cell lineages: diagrams of cell lineages including those that give rise to the anchor cell (Z1/Z4 lineages) and SM cells (M lineage)
[image: ]
(Figure from: WormAtlas, adapted from Kimble & Hirsch, 1979)
[bookmark: _Toc104029963]Literature
· PubMed and Google Scholar are two great resources for peer-reviewed publications. If you are a student or employee of Stony Brook University, you can use the following link to access most scientific articles through PubMed by logging in with your NetID and password: https://www-ncbi-nlm-nih-gov.proxy.library.stonybrook.edu/pubmed?holding=sunysblib.
· I’m not allowed to recommend Sci-Hub, as it bypasses publisher’s paywalls, so don’t use it. ;-)
[bookmark: _Toc104029964]Life cycle
[bookmark: _Toc104029965]Sexes
· C. elegans come in two sexes: self-fertilizing hermaphrodites (~99.9% of the population) and males (~0.1% of the population). Our lab studies development of the hermaphroditic reproductive system, but we use males to facilitate genetic crosses.
[image: ][image: ]
(Figure adapted from: Zarkower, 2006)
[bookmark: _Toc104029966]Larval stages
· Larval stages - L1, L2, L3, L4, etc.
[image: ][image: ]
(Figures from: WormAtlas)


[bookmark: _Toc104029967]Basic laboratory skills
[bookmark: _Toc104029968]Pipetting
[bookmark: _Toc104029969]Manual pipetters
· Pipetters allow you to transfer precise volumes of liquids. Determine which pipette to use based on the volume you need to transfer, and adjust the volume (displayed on the side) by rotating the knob on top. Firmly press the pipette into a sterile pipette tip. Press the plunger down to the first “stop” (i.e., the point where you would have to apply additional pressure to lower it further) and hold it down. Put the pipette tip into the liquid you want to transfer, and then release the plunger. To release the liquid, press down all the way to the second “stop” (this will release an additional volume of air that helps all of the liquid to be expelled).

	Pipetter
	Volume range
	Tips

	P2
	0.2-2 µL
	Small

	P20
	2-20 µL
	Medium 

	P200
	20-200 µL
	Medium 

	P1000
	200-1000µL
	Large 



[bookmark: _Toc104029970]Electronic pipetters
· An electronic pipetter allows you to transfer larger volumes of liquid than a manual pipetter. They are used with serological pipettes, which have gradations for measuring volume. The pipetter has two buttons: the top one is for aspiration (suction), and bottom one is for dispensing (releasing).
[bookmark: _Toc104029971]Sterile technique
· Use gloves, clean tips, spray down surfaces with ethanol (EtOH), open flame
[bookmark: _Toc104029972]Strains
[bookmark: _Toc104029973]Strain library
[bookmark: _Toc104029974]Freezing strains
· Label the strain name on the side of the tube, and on top of the lid, if possible.
· Mix freezing medium, trehalose (1:1, worms in M9) 
· Make sure to add it to the lab spreadsheet
[bookmark: _Toc104029975]Thawing strains
· Make sure to delete from the spreadsheet if you thaw the whole tube 
· Replace the tube or freeze new tube!
[bookmark: _Toc104029976]Ordering strains
[bookmark: _Toc104029977]Caenorhabditis Genetics Center (CGC)
· If a strain does not exist in our library, it may be available for purchase through the Caenorhabditis Genetics Center, or CGC. The strain list is available on the CGC website (https://cgc.umn.edu/strain/search).
[bookmark: _Toc104029978]Caenorhabditis elegans Natural Diversity Resource (CeNDR)
· The Caenorhabditis elegans Natural Diversity Resource (CeNDR) has a collection of wild isolates of C. elegans. The strain catalog is available on the CeNDR website (https://www.elegansvariation.org/strain/catalog).
[bookmark: _Toc104029979]Requesting strains from other labs
· If a strain is published by a lab, and it is not available through the CGC, we can request that they send it to us. 

[bookmark: _Toc104029980]Techniques
[bookmark: _Toc104029981]Strain maintenance
Reagents for plates and bacterial culture

LB
· In a 250 OR 500 ml beaker with a stir bar and you can use water from DI tap in the lab
· For 250 mls: 2.5 g Bacto-tryptone, 1.25 g Bacto-yeast, 2.5 g NaCL, ddH2 O to 250. 
· For 500 mls: 5 g Bacto-tryptone, 2.5 g Bacto-yeast, 5 g NaCL, ddH2 O to 500. 
· Pour into clean square bottles - half full - make sure caps are left loose 
· autoclave on liquid 30 setting

LB Amp Plates 
· In a 500ml flask:
· 5 g Bacto-tryptone, 2.5 g Bacto-yeast, 5 g NaCL, + 7.5 g bacto agar  add ddH2 O to 500. (you can use water from DI tap in the lab for this)
· Autoclave liquid 30 setting 
· Let cool until you can hold hand to flask when cool 
· While the flask cools take out an aliquot of Amp from the box labeled Amp stocks in the freezer in the lab
· Add 250 microliters of 100 mg/mL ampicillin
· gently swirl the flask to mix - try to not make it too bubbly.
· Then pour into large plastic dishes (you can legit tip the flask and pour - make sure bottom totally coated - maybe about ⅓ -½ of the dish is full)
· If you do not use all the amp in the tube place a dot on the top and place back in freezer 

IPTG Protocol
· Dissolve 1g of IPTG in 4mL of ddH2O and dispense into aliquots + freeze

Worm Media (M9) 
· 3 g KH2PO4, 6 g Na2HPO4, 5 g NaCl, 1 ml 1 M MgSO4, H2O to 1 liter. Sterilize by autoclaving
· put into glass rectangular screw cap bottles – do not tighten cap fully
· Autoclave - 50 min (liquid setting)

[bookmark: _Toc104029982]Plates
· Worms are cultured on petri dishes (i.e., “plates”) containing agar and bacteria. There are several kinds of plates you will use, depending.
· Unseeded plates: contain agar only
· Seeded plates: contain agar and OP50 E. coli bacteria
· Mating plates (AKA “sticky bacteria”): same as seeded plates, but more concentrated to encourage mating (also used to transfer worms)
· RNAi plates: contain agar and bacteria that induces knockdown of a particular gene/sequence

· Making NGM plates 
· Equipment and Reagents
· NaCl
· Agar
· Peptone
· 5 mg/ml cholesterol in ethanol (Do not autoclave!)
· 1 M KPO4 buffer pH 6.0 (108.3 g KH2PO4, 35.6 g K2HPO4, H2O to 1 liter)
· 1M MgSO4
· Petri dishes s(small)
· Per 250mL 
· Mix 0.75 g NaCl, 4.25 g agar, and 0.875 g peptone in a 1 liter Erlenmeyer flask. 
· Add 243 ml ddH2O – get water from the shared Bio Dept space.
· Cover the mouth of flask with aluminum foil. 
· Autoclave for 50 min (liq30 or liq45 depending on volume) 
· Cool flask in 55°C water bath for 15 min - or on benchtop so it is still hot but can touch the flask.
· Add 0.25 ml 1 M CaCl2, .25 ml 5 mg/ml cholesterol in ethanol, .25 1 M MgSO4 and 6.25 ml 1 M KPO4 buffer (make sure it’s cool so that the reagents you add don’t crash out of solution!)
· Swirl to mix well.
· Using sterile procedures, dispense the NGM solution into petri plates 8mL per petri dish. (next to the flame) 
· Leave plates at room temperature for 2-3 days before use to allow for detection of contaminants, and to allow excess moisture to evaporate. Plates stored in an air-tight container at room temperature will be usable for several weeks. Or placed at 4deg fridge for longer storage. 

· Seeding NGM plates with OP50
· Using sterile technique, apply approximately 200 ul of E. coli OP50 liquid culture to NGM plates
· Keep the lawn in the center. Allow the E. coli OP50 lawn to grow overnight at room temperature or at 37°C for 8 hours (cool plates to room temperature before adding worms). 
· Seeded plates stored in an air-tight container will remain usable for 2-3 weeks.

[bookmark: _Toc104029983]Picking
· Worms can be moved from one plate to another or a slide via picking. The protocol is as follows:
· Acquire a worm pick. A worm pick is made by fusing a platinum wire to the end of a Pasteur pipette, often fitted with pencil grip.
· Flame-sterilize your worm pick by placing the platinum wire in the flame until it glows. Let it cool for a few seconds. (Note: you must flame-sterilize between strains to prevent cross-contamination)
· Pick up some “sticky bacteria” from a mating plate. Don’t pick up too much or it will just fall off of your pick.
· Pick up worms from one plate through scooping or tapping them with the sticky bacteria.
· Drop off worms on the second plate by gently swiping the pick back and forth. Be careful not to press down too hard or you may kill the worms and/or gouge the plates.
[bookmark: _Toc104029984]Chunking
· Eventually, worms will overpopulate a plate and run out of food. In order to maintain strains and prevent starvation, “chunking” can be used as an alternative to picking. The protocol is as follows:
· Acquire a clean 50 mL conical tube, remove the cap, and place it on a heat-resistant surface (i.e., your lab bench). Heat the wide end of a metal spatula in the flame of your bunsen burner until it is red hot, and then immediately press it through the cap in order to create a slit wide enough for the spatula can fit through. Fill the 50 mL conical tube with ~20-25 mL of 95% EtOH (enough to cover the wide end of the spatula) and store it with the spatula and cap to limit evaporation.
· Flame-sterilize your spatula by removing it from the ethanol and lighting it with the bunsen burner before the ethanol evaporates. (You don’t need to hold it in the flame).
· Cut a chunk out of the plate (size depends on how many worms you want to transfer) and transfer it to a new plate (doesn’t matter - face up, face down, they’ll still crawl off).
· Tapping the plate on your bench helps to secure the chunk to the new plate and prevents it from falling to the lid when you store them upside-down.
[bookmark: _Toc104029985]Incubators
· We curretnly have 2 incubators for C. elegans: 18 °C and 22 °C. The 18 °C is located in the shared equipment space and the 22 °C in on the benchtop. Temperature-sensitive strains should be kept in the 18°C. The worms will grow slower at colder temperatures, and faster at warmer temperatures.
[bookmark: _Toc104029986]Bleaching
[bookmark: _Toc104029987]L1 synchronization
· Worms can be synchronized in development for experiments through bleaching. The protocol is as follows:
· Ideally, you will want to bleach 6 plates filled with gravid adults. Add 1 mL of distilled water to each plate. Swirl the plates and/or use your pipette to remove worms from the bacteria. Tilt the plates and transfer the water and worms to a 15 mL conical tube. Repeat with all of the plates.
· Add water such that the final volume in the conical tube is 8 mL.
· Add 600 µL of 5M base (NaOH or KOH) to the tube.
· Add 1200 µL (600 µL x 2) of bleach to the tube.
· Incubate the tube on the rocker for 5 minutes. After 5 minutes, inspect the tube by holding it up towards the light or by viewing it under a dissecting scope. You should wait until no (or very few) adult bodies are left. Note that this is very time sensitive -- bleaching for too short a time will result in undissolved adults, whereas bleaching for too long will dissolve the eggs. May take up to 10 minutes. 
· Spin down the tube in the conical tube centrifuge at 250g for 2 minutes. Use a balance (with about ~10 mL of fluid) if necessary. Dump the supernatant down the sink (do this in one motion - repetitive pouring can disrupt the pellet).
· Fill the tube with water (up to the 15 mL mark). Start by adding a little bit, flicking the tube to resuspend the pellet, before filling to the top. Spin down the tube at level 250g for 2 minutes. Remember to change your balance, if necessary. Dump the supernatant.
· Repeat the water wash. (One wash is sufficient if you’re in a rush)
· Perform two washes with M9. (One wash is sufficient if you’re in a rush)
· After the final wash, resuspend with ~2-3 mL of M9 buffer and incubate on the rocker. Use the rocker in the 15 or 20 degree incubator for temperature-sensitive strains.
· The eggs will hatch and arrest in the L1 stage of development in starvation conditions. You can plate these worms 1-2 days after bleaching.
[bookmark: _Toc104029988]Spot-bleaching
· Plates that are particularly contaminated with bacteria can be cleaned up with spot-bleaching. The protocol is as follows:
· Prepare a small aliquot of 1:1 solution of bleach and 5M base (NaOH or KOH).
· Pipette 20 μL of this solution to a clean, seeded plate.
· Transfer 20 gravid adult worms to the drop and cover the plate with its lid to avoid evaporation.
· After several minutes, you should see a line of eggs left behind. If the adult bodies are still in-tact, you can add a little more of the bleach-base solution. If all of the eggs have dissolved, you should repeat the process. (Reminder: Always keep your original plates in case your spot-bleaching fails.)
· Retrieve hatched L1s the following day and transfer them to a clean plate.
[bookmark: _Toc104029989]RNA interference (RNAi) plates
[bookmark: _Toc104029990]RNAi library
· We currently have an RNAi sub- library made by Dr. A and Anya Feng this is located in the -80 in the Morell Basement
· Buy Fall 2022 we should have the entire Vidal library
[bookmark: _h25ulk48333q][bookmark: _Toc104029991]Overnight culture
· Determine how many cultures you want to set up and acquire that number of glass culture tubes plus one extra.
· Add 5-7 mL (depending on how much bacteria you need) of lysogeny broth (LB) media to each tube using an electronic pipette.
· Add antibiotic (ampicillin or carbenicillin), such that your final ratio of antibiotic to LB media is 1:500 for carbenicillin, or 1:1,000 for ampicillin. Skip this step if your LB was pre-treated with antibiotic.
· Inoculate your tube by collecting your sample (either through a frozen stock solution or picking a colony from a streak plate) with a sterile toothpick or pipette tip. If the toothpick or pipette tip get stuck to the side of the tube, gently flick or carefully tilt the tube to get the colony incubated in the LB. 
[bookmark: _Toc104029992]Inducing RNAi bacteria
· Following overnight culture, add 0.8M IPTG such that your final ratio of IPTG to LB media is 1:500 (e.g. 5 mL LB media & 10 µL antibiotic). Incubate in the warm room with shaking for 1 hour.
[bookmark: _Toc104029993]Preparing IPTG + antibiotic plates
· Unseeded plates are treated with an antibiotic (ampicillin or carbenicillin) to prevent contamination and IPTG to induce bacteria. Determine how many plates you would like to make, and round up by ~10%. Prepare a master mix that contains 10 µL of 0.8M IPTG and 2.5 µL of antibiotic (ampicillin or carbenicillin) for each plate and mix thoroughly by pipetting up and down.
· Pipette 12.5 µL of the master mix solution onto each plate. Place a glass spreader in a small beaker containing enough 95% ethanol (EtOH) to cover the bottom of the spreader. Light it with the bunsen burner to sterilize it, let it cool for several seconds, and then spread the liquid on the plates. 
[bookmark: _Toc104029994]Plating RNAi bacteria
· After the RNAi bacteria has been induced with IPTG, it can be used to seed the IPTG + antibiotic treated plates. Pipette 125-250 µL of bacteria onto each plate. The more bacteria you plate, the more worms each plate can accommodate, but the plates also take longer to dry. Let the plates dry overnight and room temperature, and then store them at 4 °C, either in the cold room or an incubator.
[bookmark: _hdhura23vb52]
[bookmark: _Toc104029995]Crosses
[bookmark: _Toc104029996]Generating males
[bookmark: _Toc104029997]Heat shock
[bookmark: _Toc104029998]Cross with N2 males
[bookmark: _h2xb9dsfjnp][bookmark: _Toc104029999]See Worm Book (http://www.wormbook.org/chapters/www_introandbasics/introandbasics.html)

[bookmark: _c0q71dr3vd0t][bookmark: _Toc104030000]-80 °C Freezer Storage
[bookmark: _ww50q9o65ma8][bookmark: _Toc104030001]Vidal RNAi library
[bookmark: _ki0gq4sk4tew][bookmark: _Toc104030002]Streaking RNAi clones
Clones to streak are located here: https://docs.google.com/spreadsheets/d/1r6UAN7sroIY8o8yN_6mXUUTAHNVLTAUBzpdiP0vyRAY/edit#gid=873493982
· Take a bucket from the sink and fill it with 2 scoops of ice
· Take out an amp plate from the refrigerator and warm it 
· Use a sharpie and separate the plate into 6 sections (label 1-6) and label each of the gene + date 
· Take out samples from the RNA library in the freezer (make sure you take out boxes based on the plate # (max only have 3 out)
· Identify the location of the specific clones based on the column and row listed and use a pipette tip to scrape the bottom - wearing gloves and using a sterile pipette tip
· Streak 2 squiggly lines with the tip by holding the edge and gently drawing on the top without scratching it (do not poke through it, can rest elbow on the table to help)  
· Throw out the old tip and take out a new one to draw a new line that intersects with a previously drawn one instead of picking new clones (it’ll dilute it) and draw 1 more line with the same tip
· Place the streaked plates in the warm room overnight

RNAi SM cell project sub-library
[bookmark: _Toc104030003]Plasmid library
[bookmark: _Toc104030004]Strain library

[bookmark: _jnege6eu47zd]
[bookmark: _w8tr9iujjeqz][bookmark: _Toc104030005]Molecular biology

[bookmark: _Toc104030006]ApE (A plasmid editor)
[bookmark: _fu5vk7aikekl][bookmark: _x9e0ih8hsq12][bookmark: _Toc104030007]Download this free software to be able to view, annotate and design plasmids

[bookmark: _Toc104030008]Plasmid DNA extraction (miniprep) follow manufacturer protocol
If prepping extraction for injection be sure to use the PureLink Kit and the ‘magic’ buffer 
[bookmark: _wqdwyn5gbjc5]
[bookmark: _Toc104030009]Primers
[bookmark: _Toc104030010]Designing primers
Tm calculator – I like to use the one from NEB 
[bookmark: _Toc104030011]Ordering primers
	Figure this out with Dr.A
[bookmark: _Toc104030012]Diluting primers
· Primers are shipped in a lyophilized (freeze-dried) state. Upon receipt, spin the tubes briefly in a microcentrifuge to prevent product loss when opening the tube.
· Check the DNA concentration (listed both on the accompanying specification sheet and on the tube’s label) and resuspend with 10 µL of distilled water (dH2O) per 1 nmole of primer concentration to create a 100 µM stock solution (e.g. 24.2 nmole → 242 µL dH2O).
· In a separate tube, make a 1:10 dilution in dH2O to create a 10 µM working solution (e.g. 1 µL primer & 9 µL dH2O).

[bookmark: _Toc104030013]Polymerase chain reaction (PCR)
[bookmark: _mqrmpl4rrsvy]
[bookmark: _Toc104030014]Reagents
	Use the kit in the lab and refer to the manufacturer’s instructions
[bookmark: _Toc104030015]Reaction conditions
· General PCR conditions are dependent on the polymerase you use. There are often preset programs saved on the thermocycler that you can edit.
· Annealing temperature: dependent on the polymerase used and primer sequences (annealing regions only) and can be calculated using the NEB Tm calculator (https://tmcalculator.neb.com/#!/main)
· Extension time: dependent on the polymerase used (e.g., Q5® High-Fidelity DNA Polymerase requires 30 s per kilobase) 

[bookmark: _Toc104030016]Gel electrophoresis
[bookmark: _xt3ep4rcfec0]
[bookmark: _Toc104030017]Restriction digestion
[bookmark: _Toc104030018]Reagents
· Determine the enzyme(s) you want to cut with and the buffer they have 100% activity in using the following link: https://nebcloner.neb.com/#!/redigest

	Volume
	Reagent

	3 µL
	Buffer (e.g., 1.1, 2.1, 3.1, or CutSmart)

	1 µL
	Each restriction enzyme

	1 µL
	Calf-intestinal alkaline phosphatase, or CIP (*only if single enzyme is used; prevents recircularization)

	variable
	Plasmid DNA (1 µg or 1000 ng)

	variable
	dH2O (up to 30 µL total volume)

	30 µL
	TOTAL



[bookmark: _Toc104030019]Reaction conditions
· Incubate your restriction digestion in the thermocycler at 37°C. Technically the manufacturer claims that the enzymes can cut within 1 hour or less, however, it’s best to incubate them for at least 2-3 hours, or ideally overnight.

	Temperature
	Time

	37°C
	∞


[bookmark: _r12c1tmtadbh]
[bookmark: _Toc104030020]Ligation
[bookmark: _5hnhfgis80]

[bookmark: _Toc104030021]Gibson assembly


[bookmark: _Toc104030022]Transformation


[bookmark: _Toc104030023]Colony PCR
· Full protocol here https://www.neb.com/protocols/2012/09/13/protocol-for-quick-load-taq-2x-master-mix-m0271
· For verification of RNAi clones: Select 3 individual colonies for each clone - Label clearly on plate 1,2,3
(use a sharpie to circle ind. colonies- pick ones that are separated from the rest- ones that you can touch without touching the others)
· Make the PCR reaction master mix
	Per reaction 
6.25 ul of 2x Master Mix taq reaction mix
0.25 ul 10uM Forward Primer (M13) 
0.25 ul 10uM Reverse Primer (DM144) 
If you have 6 clones-streaked x 3 colonies per clone = 18 + 2 (for pipetting error) = 20 rxn 
· For 20 reactions (in a 1.5 ml eppendorf)
125 ul of 2x Master Mix taq reaction mix (1:10 dilution needed) 
5 ul 10uM Forward Primer (M13) 
5 ul 10uM Reverse Primer (DM144)
· Pipette to mix well 
· Pipette 6 ul of molecular biology water into 18 PCR tubes (each tube is labeled for each colony like 1.1, 1.2, 1.3 to 6.3)
· Pick each colony into the corresponding tube using a p10 tip (only touch the edge of the colony with the tip - do not take the entire colony as you will need to go back and take more from this)
· Gently swirl the pipette tip in the tube and then throw away. 
· After all colonies have been suspended in water add 6.75 ul of the master mix to each tube and flick to mix. 
· Add tubes to the PCR machine and run the taq Colony PCR protocol On the PCR machine : Open lid, place all tubes inside, click open method select or program appropriate method


[bookmark: _Toc104030024]Sequencing
[bookmark: _igp2pqe8omat][bookmark: _Toc104030025]Ordering sequencing
[bookmark: _ezuirsnts0xe][bookmark: _Toc104030026]Sample preparation and submission
· You will want to use primers that sit approximately 50 basepairs upstream of the sequence you would like to read.
· X µL - DNA (250-500 ng)
· 0.32 µL - Primer (10 µM)
· X µL - dH2O (up to 8 µL)
· 8 µL - TOTAL
· Drop off your samples in the small refrigerator inside of LSB 253. The samples will be picked up the next business day and results will be available the following business day.
[bookmark: _Toc104030027]Sequencing results
· Download your sequencing data, searchable by date. Each sequence will come in 2 file types: .ab1 and .seq. The *.ab1 files are chromatogram files that show you the confidence of each nucleotide call. The *.seq files are standard sequence files that only show the consensus sequence.
· Using the program A plasmid Editor (ApE), open your sequencing files along with the file you would like to compare it to. Tools > Align Sequences. Choose your reference sequence from the drop-down menu. Highlight the sequence files you would like to align. If you only want to look at a certain region, you will need to highlight the region in your reference file and check “Selection Only.” If you want to align a sequence that is the reverse complement of your reference sequence, select “Rev-Com”.
· Make note of the number of matches, mismatches, and gaps in your alignment. If you have mismatches or gaps, look through the sequence to see where they occur. You typically cannot trust the first 20-30 bases or anything beyond ~800 bases of a DNA sequencing read. Again, you can use the chromatogram file (.ab1) to determine the relative confidence of each call.
[bookmark: _m574f4tvf6n3]
[bookmark: _Toc104030028]CRISPR

[bookmark: _Toc104030029]Designing guides and repair templates
[bookmark: _Toc104030030]Prepare sequence file in ApE
· Navigate to WormBase (https://wormbase.org/) and search for your gene of interest.
· Select “Sequences” from the left side bar.
· Select the transcript (i.e., isoform) you would like to view.
· Select “Unspliced + UTR + upstream + downstream”.
· Copy and paste this sequence into ApE (download here: https://jorgensen.biology.utah.edu/wayned/ape/).
· Annotate the sequence in ApE. Note that exons are uppercase while introns, UTRs, and upstream/downstream regions are lowercase. You will at least want to mark the start and stop codons.
· Copy a region of the sequence in WormBase and find it (Edit > Find.. or Ctrl + F) in the ApE file.
· Annotate the highlighted region (Features > New Feature) by giving it a name and color (you don’t need to specify the “Feature type”).
· Save the file (e.g., gene-x.ape).
[bookmark: _Toc104030031]Analyze guides using ApE
· Identify the start codon (ATG) or stop codon (TAG/TAA/TGA) of your gene of interest.
· Highlight the desired insertion site (start codon for N-terminus, stop codon for C-terminus) + ~75 bp on either side.
· Run the analysis for potential guide sequences (Tools > sgRNA Analysis).
· Record the information in your lab notebook.
[bookmark: _Toc104030032]Analyze guides using GuideScan
· In the WormBase page for your gene of interest, select “Location” from the left side bar.
· Click on the “Genome Browser Preview.”
· In the window there is a blue and white toolbar on top, in between two gray scales that represent genomic coordinates. Using the lower gray scale, highlight the desired insertion site + ~100 bp on either side. It will automatically zoom into that region.
· Copy the genomic coordinates from the box in the blue and white toolbar. It will include the chromosome number followed by the start and end position of the locus you zoomed in on. [e.g., I:6742428..6742627 (200 b)]
· Navigate to the GuideScan website (http://www.guidescan.com/).
· Paste the genomic coordinates into the box. Add “chr” in front of the chromosome number, replace the “..” between positions with a dash “-”, and remove the part in parentheses at the end [e.g., “(200 b)”].
· Under “Parameters,” change the genome build to “ce11” and leave the enzyme as “SpCas9.”
· Click “guide me!” to run the analysis for potential guide sequences.
· Record the information in your lab notebook.
[bookmark: _Toc104030033]Check both termini
· Repeat the guide analyses for the opposite terminus (N-terminus vs. C-terminus).
[bookmark: _Toc104030034]Select a guide
· Select 1-3 best guide(s) based on the following criteria:
· Off-targets: Your guide should have no off-targets (it shouldn’t cut a sequence other than in your gene of interest)
· Location: The closer to the insertion site, the more efficient your guide will be. You can test this by using the find feature in ApE to search for where the guide 
· Score: The higher the score (0-1 on ApE, 0-100 on GuideScan), the more efficient your guide will be.
· Copy and paste the guide from GuideScan (not ApE) to ensure correct directionality.
[bookmark: _Toc104030035]Design repair templates
· After choosing a guide, return to your sequence file that contains upstream and downstream regions.
· Find your guide within the sequence and annotate it.
· Recode the region between the PAM site (NGG sequence immediately 3’ of the guide, where N is any nucleotide) and the insertion site (in front of the start codon for 5’ insertion, or stop codon for 3’ insertion) using codon wobbles. Make sure to consider the frame of your protein, not your guide. Use a codon table to replace the 3rd base in a codon without altering the amino acid generated. If you have multiple options, choose the codon that has a higher frequency of usage in C. elegans (link: https://www.genscript.com/tools/codon-frequency-table). If the start codon (ATG) is included in the guide, then you don’t need to recode at all.
· Save this as a new ApE file (e.g., gene-x_sgRNA_mutated.ape).
· Copy ~1000-1200 bp upstream and ~1000-1200 bp downstream of your insertion site (NOT the guide cut site). These will be your left and right homology arms, respectively.
· Open the ApE file for your repair vector. This plasmid will have your insert (fluorescent protein and/or auxin-inducible degron plus self-excising cassette) flanked by two ccdB selection markers. The ccdB sites will be replaced with your homology arms.
· Highlight the enzyme restriction sites (Enzymes > Enzyme Selector...) that you will use to cut out the ccdB sites. In the case of pTNM063 (TagRFP-T::AID), you will use SpeI and ClaI for N-terminal insertions, or SpeI and AvrII for C-terminal insertions.
· Hover over the highlighted restriction sites. The caret (^) indicates where the sites are cut (e.g., ClaI: AT^CGAT). Cut out the region between the two restriction sites (based on where they are cut) and insert your homology arm. Note that you can delete the base(s) leftover by the restriction sites to maintain frame as long as they are not part of a coding region such as the flexible linker or a gene.
· Check that the frames of your homology arm and insertion are compatible. This applies to the coding region (i.e., promoters and 3’ UTRs do not need to be in-frame). If they are not, you may need to delete the nucleotides left by the cut restriction site, or you may need to add 1-2 bp between your homology arm and insert. You can check the frame by highlighting starting from the start codon and checking the number within arrows (“<>”) under “Length” at the top of the ApE screen - it will be 0 if the nucleotides are a multiple of 3.
· If there is not a flexible linker between your gene and insert, you may want to add one. This prevents steric hindrance of your tag interfering with protein function.
[bookmark: _Toc104030036]Design primers
· Design four primers to amplify the homology arms and one primer to amplify the guide. Aim for ~20 bp each of annealing and overhang sequence, but be sure to match melting temperatures (within 5°C) of each part (i.e., annealing or overhang) of your primer pairs (Tm calculator: https://tmcalculator.neb.com/#!/main). Note, you can use the reverse-complement feature (Edit > Copy Rev-Com) for generating reverse primers:
· F primer to amplify 5’ end of left homology arm with overhang to repair vector
· R primer to amplify 3’ end of left homology arm with overhand to repair vector
· F primer to amplify 5’ end of right homology arm with overhang to repair vector
· R primer to amplify 3’ end of right homology arm with overhang to repair vector
· F primer to use with the universal primer DQM412 to add sgRNA sequence to guide plasmid (pDD122). Note that your guide needs to be in the orientation that the PAM site is on the right (you may need to reverse-complement it), but do not include the PAM site. The primer sequence is as follows:
tcctattgcgagatgtcttG [20 bp unique guide sequence] GTTTTAGAGCTAGAAATAGC
· R primer to screen guide via colony PCR. The primer sequence will be the reverse complement of your 20 bp unique guide sequence
· Check that your primers anneal to the plasmid with the homology arms.
[bookmark: _Toc104030037]Clone repair template
· Digest the repair vector with the appropriate enzyme pair (e.g., often one of the following: SpeI/ClaI/AvrII) to remove the dual ccdB sites (~600 bp band). In the case of pTNM063 (TagRFP-T::AID), you will use SpeI and ClaI for N-terminal insertions, or SpeI and AvrII for C-terminal insertions.
· Amplify left homology arm (LHA) and right homology arm (RHA) using the appropriate primer pairs.
· Use the PCR purification kit to purify the LHA and RHA amplicons as well as the cut vector (we don’t gel purify the cut vector because, even if it reassembles with itself, the ccdB sites will be selected against anyway).
· Perform 3-fragment Gibson assembly of cut vector and inserts (LHA & RHA).
· Transform NEB 10-beta cells with Gibson assembly product (for ccdB- selection).
· Verify repair templates via colony PCRs using M13F & the LHA R primer, and the RHA F primer & M13R.
· Sequence with M13F and M13R.
[bookmark: _Toc104030038]Clone guide
· Cut pDD122 with EcoRV & NdeI (7902 & 230 bp).
· Gel or PCR purify cut vector.
· Add guide sequence to pDD122 by amplifying it with guide F primer & DQM412.
· Perform Gibson assembly of cut vector and insert.
· Transform NEB 10-beta cells.
· Verify sgRNAs via colony PCR with AWK124 & guide R primer (~635 bp).
· Sequence with DQM22.
[bookmark: _eiqu50tu71p9]
[bookmark: _Toc104030039]Microinjections
[bookmark: _Toc104030040]Needles
[bookmark: _Toc104030041]Pulling needles
· Turn on the power switch, located on the left side of the cabinet, and open the cabinet cover.
· Type in the desired program number using the keypad and then press the ENTER key. Currently we use program #2 for C. elegans microinjections.
· Load the glass into the V-groove, slide it into the clamp, and tighten the clamping knob.
· Depress the spring stop on each puller bar to release them from their catch position.
· Pull both bars towards each other using the finger holds. Hold the puller bars in position using the thumb and index finger of one hand. Make sure that the capillary tube is guided through the filament.
· Loosen the clamping knob slightly and carefully slide the glass through the holes in the side of the heater chamber and into the V-groove of the opposite puller bar.
· Tighten down both clamping knobs.
· Press the PULL key on the keypad.
· Loosen the clamping knobs and remove the needles from the puller bars.

[image: ]
(Figure from: P-97 Flaming/Brown Micropipette Puller Operation Manual)

[bookmark: _Toc104030042]Injection mix preparation
[bookmark: _33untx1xohbo][bookmark: _Toc104030043]CRISPR plasmid injections
· Spin down your injection mix components for 2 minutes in the 4 °C centrifuge.
· Pipette from the meniscus 
[bookmark: _Toc104030044]Injection & recovery
[bookmark: _Toc104030045]Turning on the injection rig
· Open the air line by turning the knob labeled “AIR” on the wall counter-clockwise.
· Pull the lever on the gasket away from the wall.
· Adjust the pressure on the gasket to 60 PSI by turning the knob clockwise.
· Turn on the Pico-Liter injector using the power switch on the right side
[image: ]
(Image from: Warner Instruments)
· Adjust the Pressure Meter Select knob such that the white line is pointing to Pinject.
· Increase the injection pressure to 45 by turning the Pinject knob clockwise.
· Set the injection time to 3 seconds by adjusting the “Injection Time Set” knob.
[bookmark: _Toc104030046]Loading needles
· Place the needle vertically in the foam needle holder with the needle facing down.
· Pipette 0.7 µL of injection mix onto the top of the needle. It’s a good idea to load at least two needles, in case one of the needles is faulty or gets broken.
· Wait several minutes for the liquid to sink down through capillary action. Don’t let the needles sit out for too long though, or the injection mix will evaporate. Cover the top of any extra needles with Parafilm.
[bookmark: _Toc104030047]Preparing agar pad
· Acquire agar-coated cover glass and transfer a small drop of halocarbon oil onto the agar pad.
· Break off a small piece of a capillary tube and place it into the drop of halocarbon oil.
· Place the agar pad on the stage and manually move the stage and adjust the focus in order to focus on the edge of the capillary tube.
[bookmark: _Toc104030048]Opening needles
· There are three knobs to adjust the position of the needle in X, Y, and Z dimensions. It’s best to start out with them all set to zero, for maximum range.
· Put the needle into the holder and tighten the seal.
· Adjust the injection pressure and time.
[bookmark: _Toc104030049]Mounting
· Healthy, young adult worms (adults with a single row of eggs) should be transferred to an unseeded plate to separate them from bacteria, which will clog the needles. Using a special loop worm pick, pick up halocarbon oil, and then pick up worms from the unseeded plate. Carefully transfer the worms and halocarbon oil to a clean space on the agar-coated cover glass. Try to straighten the worms and align them vertically. You want them to be immobile, but you also don’t want to crush and kill them -- so be careful! A beginner should only mount 1-2 worms at a time. More experienced injectors may mount several at once.
[bookmark: _Toc104030050]Injection
· Place the agar-coated cover glass onto the injection microscope stage.
· Locate and focus on the worm(s) at the lower level of magnification.
· Lower the needle such that the tip is in focus.
· Go to the higher level of magnification and adjust the focus such that the nuclei on the periphery of the gonad are in focus.
· Lower the needle using the fine adjustment knob until the very tip is in focus.
· Carefully move the stage manually such that the worm’s gonad is pushed into the needle.
· Once the needle is in position, press the inject button. You should expect to see a visible swell within the gonad, but not so much volume that damage is done to the organ.
[bookmark: _Toc104030051]Recovery
· Pick up a small volume of M9 with your mouth pipette. Dispense a drop of M9 over the injected worm(s). Wait until the worm(s) become completely suspended in the M9, and then pick them up with your mouth pipette. (make sure there is some M9 in your mouth pipette before attempting this, or else the worms can get stuck to the side of the dry glass) and transfer them to a clean seeded plate (1-2 per plate).
[bookmark: _Toc104030052]Shutting down the injection rig
· Adjust the pressure on the gasket to 0 PSI by turning the knob counter-clockwise.
· Close the gas line by turning the knob on the wall clockwise and push the lever on the gasket toward the wall.
[bookmark: _o0a8yqhif82z]
[bookmark: _Toc104030053]Screening
[bookmark: _Toc104030054]Self-excising cassette (SEC)
· A screening tool developed by the Goldstein lab to identify successful integrants.
· sqt-1(d): dominant mutation that makes worms exhibit the roller phenotype
· hygR: dominant allele that makes worms resistant to the drug Hygromycin
· LoxP: recognition sequences flanking the SEC that can recombine upon expression of Cre
· hs::Cre: heat-shock inducible Cre, a recombinase that facilitates LoxP recombination
[image: ]
(Figure from: Dickinson et al., 2015)

[bookmark: _Toc104030055]Hygromycin (Hygr) treatment
· Aliquots of Hygromycin can be made by diluting 1 mL of Hygromycin B Solution (50 mg / mL in PBS) in 9 mL of distilled water in 15 mL conical tubes.
· Thaw tubes of Hygromycin from the freezer (one 10 mL tube is enough for ~25 plates). Frozen tubes can be thawed overnight in the refrigerator.
· Add 400 μL of Hygromycin per plate and swirl the plate to spread it evenly.
· Once dried, return the plates to 25°C.
[bookmark: _Toc104030056]Determining integration
· a
[bookmark: _Toc104030057]Homozygosing
· Ideally, you want to homozygose your allele before attempting to flox it.
· Occasionally, the presence of the SEC at the N-terminus of a gene (i.e., between the promoter and coding region) interferes its function and is lethal. In this case, you will need to flox the strain as a heterozygote and confirm the presence of your integration through other means (i.e., visualization of a fluorescent marker or PCR).
[bookmark: _Toc104030058]Floxing
· The Goldstein lab recommends picking 6-8 L1/L2 stage larvae to each of three new plates. Heat shock the plates at 34°C for 4 hours or 32°C for 4-5 hours in an air incubator. Following heat shock, return the plates to 20°C or 25°C.
· Several days later, pick wild-type (non-roller) progeny to new plates. Be aware that the roller phenotype does not appear until L3, so it is advised to pick only L4 and adult animals. If you cannot find any wild-type animals, repeat the heat shock step.
[bookmark: _Toc104030059]Microscopy
[bookmark: _Toc104030060]Microscopes
· Our lab has a few kinds of microscopes. All microscopes have the same basic parts:
· Illumination/light source (e.g., bulb, LED, laser)
· Something to focus light on the sample (e.g., condenser)
· Sample/specimen (e.g., worms!)
· Something to collect light from the sample (e.g., lens)
· Detector (e.g., camera, eyes)
[bookmark: _Toc104030061]Stereo/dissecting microscope
· Each lab bench has a stereo/dissecting microscope. Only one is equipped with a camera, therefore, these are used for daily tasks other than imaging, such as strain maintenance and setting up crosses.
[bookmark: _Toc104030062]Fluorescence dissecting microscope
· The fluorescent dissecting scope is used to visualize fluorescent protein expression in worms on plates, without needing to mount them on slides. This is especially useful for screening injected worms and cross progeny.
[bookmark: _Toc104030063]Epifluorescence microscope
· The epifluorescence microscope is used to visualize worms at high magnification. The scope uses a light engine that allows you to visualize multiple wavelengths of light.Typically this scope is only used for non-imaging tasks (i.e., scoring for anchor cell invasion, screening injections or crosses, etc.) or imaging in DIC only.




[bookmark: _Toc104030064]Preparing slides
[bookmark: _4baoogicxwme][bookmark: _Toc104030065]For static imaging
· A
[image: ]
(Figure from: Kelley et al., 2017)
[bookmark: _73qo73g8xo11][bookmark: _Toc104030066]Time lapse mounts
· A
[image: ][image: ]
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(Figure from: Kelley et al., 2017)
[bookmark: _7lz4bs1t9cq9]
[bookmark: _Toc104030067]Köhler illumination
[bookmark: _pi6m0zpr3r7g]
[bookmark: _Toc104030068]Channels
[bookmark: _rwbhecel7nox]
[bookmark: _Toc104030069]Differential interference contrast (DIC) / Nomarski optics

[bookmark: _Toc104030070]Fluorescent channels
[bookmark: _w1atp22f3tyn]
[bookmark: _Toc104030071]Image acquisition
[bookmark: _Toc104030072]Static imaging

[bookmark: _Toc104030073]Time lapse imaging

[bookmark: _Toc104030074]Image processing
[bookmark: _Toc104030075]FIJI/ImageJ

Instructions for image processing using FIJI:

1. Download FIJI image processing software for free at: https://fiji.sc/
2. Open images:
File > Open..
3. Change bit depth of images (if necessary):
Image > Type > 16-bit
4. Overlay and colorize channels:
Image > Color > Merge Channels..
>> C2 (green): select basement membrane (BM) image
>> C4 (gray): select DIC image
>> C6 (magenta): select anchor cell (AC) image
>> Select “Create composite” and “Keep source images”
>> OK
5. Adjust brightness and contrast of each channel:
Use the slider to at the bottom of the composite image to switch between channels
(the color of text on top of the image corresponds to the channel selected)
Image > Adjust > Brightness/contrast..
>> Adjust settings to maximize signal while minimizing background
6. Rotate composite image:
Image > Transform > Rotate 90 degrees right/left
Image > Transform > Rotate..
>> Select “Preview”
>> OK
7. Save composite image:
File > Save as > PNG..


[bookmark: _Toc104030076]Importing image files
· 
[bookmark: _Toc104030077]Adjusting brightness/contrast
· 
[bookmark: _Toc104030078]Background subtraction
· 
[bookmark: _Toc104030079]Quantification
· Quantifying uniform expression
· Quantifying puncta
· Quantifying DHB
· Step 1: For single timepoint images, open the .nd file. You will want to make sure that the options I've circled are NOT checked. For timelapses, open your file by going to File > Import > TIFF Virtual Stack… and selecting your file.
· Step 2: Select the channel using the slider labeled "C", and choose the Z position using the slider labeled "Z", and the slider with the play symbol is for timelapse.
· Step 3: Select the channel you are quantifying, and click "Process" (at the top of your screen) and then select "Subtract background..." from the drop-down menu. Make sure the rolling ball radius is set to 50 and the other options are unchecked, then hit "OK".
· Step 4: Find the cell you want to quantify and get its nucleus in focus. You can use the DIC or nuclear mask channels for this.
· Step 5: You can go to "Image" (at the top of your screen), then select "Adjust" and then "Brightness/Contrast..." to adjust the image to make it easier to see. Just make sure you DON'T hit "Apply", or else it will change the brightness values in your measurements.
· Step 6: Click the "Freehand selection" tool in the toolbar. And then draw a circle around the nucleus except exclude the nucleolus (as you can see in the yellow outline below. I find it’s helpful to zoom in to my cell of interest before drawing it, you can do this through pressing Ctrl and + while hovering over the cell. Ctrl and - zooms out.
[image: ]
· Step 7: While your selection is still there, switch to the DHB channel (488 nm) and then collect the measurement. You can do this by pressing Ctrl and M, or pressing "Analyze" on the top of your screen and selecting "Measure" from the drop-down menu. This is your nuclear expression measurement. You may need to nudge your shape over slightly if the channels don't line up perfectly
[image: ]
· Step 8: Draw a shape to measure the cytoplasm (outside of the nucleus). You don't need to get the whole part, but it's good to sample as much of the cytoplasm as you can. Note, you may want to adjust your sampling of the cytoplasm to avoid background fluorescence - remember to just be consistent.
[image: ]
· One thing you'll want to do before quantifying your data is determine what measurements you want to take. You can set these by clicking "Analyze" at the top of your screen and then clicking "Select measurements..." We usually collect area, mean gray value (MGV), and integrated density (although integrated density is just area x MGV).
[bookmark: _Toc104030080]Exporting image files
[bookmark: _1ym2p2cmt5cy]
[bookmark: _Toc104030081]Imaris
· Spots function

[bookmark: _fj1ubsod1zzy]
[bookmark: _Toc104030082]Adobe Illustrator
For figure generation for publication

[bookmark: _Toc104030083]Other tools
[bookmark: _Toc104030084]Intron-Exon Graphic Maker
http://wormweb.org/exonintron 

[bookmark: _Toc104030085]Data visualization
[bookmark: _Toc104030086]Plotting data in RStudio
[bookmark: _Toc104030087]Coding basics
· To use RStudio, you will first need to download both R (https://cran.r-project.org/mirrors.html) and the more user-friendly interface RStudio (https://rstudio.com/products/rstudio/download/). 
· To annotate your code, you can begin a line with a hashtag (#), to instruct the program that the line contains your notes and not an executable command.
· Common errors for codes not working include a missing or extra quotation mark, parenthesis, or comma.
· Assignment (<-)
[bookmark: _Toc104030088]Packages
· Ggplot2 (ggplot2 cheat sheets)
· Installing packages
· Command:	install.packages(‘package’)
· Example:	install.packages(‘tidyverse’)
· Calling packages
· Command:	library(package)
· Example:	setwd(ggplot2)
[bookmark: _Toc104030089]Organizing spreadsheet
· Your data needs to be in a certain format in order for it to be read into R correctly.
· No color-coding, no spaces or special characters
[bookmark: _Toc104030090]Opening data
· Set your working directory. This is the filepath of the folder where your data file is located.
· Command:	setwd(‘filepath’)
· Example:	setwd(‘/Users/taylor/Desktop’)
· Call.
· Command:	dataset <- read.table(‘filename.txt’, header = TRUE, fill = TRUE)
· Example:	data1 <- read.table (‘dataset1.txt’, header = TRUE, fill = TRUE)
[bookmark: _Toc104030091]Organizing variables
· The default way your variables are organized is alphabetically. Use the commands “levels” and “labels” to order and rename variables, respectively.
· Command:	dataset$variable = factor(dataset$variable,
levels = c(‘value1’, ‘value2’)
labels = c(‘new_name1’, ‘new_name2’)
)
· Example:	data1$RNAi = factor(data1$RNAi,
levels = c(‘T444T’, ‘nhr-67’)
labels = c(‘empty vector’, ‘nhr-67’)
)
[bookmark: _Toc104030092]Plotting data
· ggplot
· aes
· facet grid
[bookmark: _Toc104030093]Customizing plots
· Font
· Color/Fill
· Shape
[bookmark: _Toc104030094]Statistical tests
[bookmark: _Toc104030095]P-values
· The p-value is the percentage that the difference between two groups is due to chance. Common p-value cut-offs for statistical significance include 0.05, 0.01, and 0.001.
[bookmark: _Toc104030096]Fisher’s Exact Test
· A Fisher’s Exact Test is a measure of statistical significance used in the analysis of 2x2 contingency tables. This test is often used for invasion scoring data. Fisher’s Exact Test calculators can be found online (https://www.graphpad.com/quickcalcs/contingency1.cfm). 
[bookmark: _Toc104030097]Student’s T-Test
· A Student’s T-Test is a measure of statistical significance used in the analysis of two data distributions. We often use this test to compare protein expression levels between two genotypes or treatments, for example. Student’s T-Test calculators can be found online (https://www.graphpad.com/quickcalcs/ttest1.cfm). You will either need to enter all of your data points, or enter the mean, standard deviation (SD), and N (total number of samples) per group. A Student’s T-Test can also be performed in R, by using the following command:
· Command:	t.test(Group1$Variable, Group2$Variable)
· Example:	t.test(DQM350$MGV, DQM368$MGV)

Created by Taylor Medwig-Kinney and adapted by Rebecca Adikes
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The two alternative lincages followed by Z1.ppa, Z1.ppp, Z4.aaa and Z4.aap:
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